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1. INTRODUCTION

Thank you for choosing the ACCUPAR LP-80 PAR/LAI Ceptometer from METER Group. The
LP-80 measures photosynthetically active radiation (PAR) and can use these readings in a
model to give a leaf area index (LAI) for a plant canopy. This manual includes instructions
for setting up the LP-80, verifying the calibration of the instrument, preparing samples, and
maintaining and caring for the instrument.

The LP-80 and its accessories arrive in a durable foam-padded carrying case.

Verify all LP-80 components are included and appear in good condition:

* ACCUPAR LP-80

« External PAR sensor

» 5-pin to RS-232 cable

» USB adapter cable

« USB drive with LP-80 Utility (attached to manual cover)

« #1 Phillips screwdriver

The LP-80 was shipped without batteries to preserve battery life and prevent damage to the

instrument. Install the included four AAA batteries in the LP-80 and securely attach with
washers and screws prior to use (Section 4.2.1).
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2. OPERATION

Please read all instructions before operating the LP-80 to ensure it performs to its full
potential.

Please observe the following considerations carefully:

» Keep the probe clean. Measurement accuracy may decline if debris on the probe prevents
light from entering the sensors.

» Do not immerse the instrument in water or leave it in contact with rain for long periods
of time.

« Transport the instrument in its padded hard-sided carrying case to prevent damage.

/\ PRECAUTIONS

METER instruments are built to the highest standards, but misuse, improper protection,

or improper installation may damage the sensor and possibly void the manufacturer’s
warranty. Before using the LP-80, follow the recommended instructions and arrange proper
protections to safeguard sensors from damage.

2.1 CONFIGURING

Before taking measurements, configure the LP-80 date, time, and location to ensure
accurate timestamps and measurement readings. The date and time can also be changed
using the LP-80 Utility (Section 3.3), which automatically sets the date and time on the
LP-80 each time it is connected.

Use the following steps to configure the LP-80 prior to readings.

1. Press the POWER button to turn on the LP-80.

2. Press MENU to navigate to the Configuration tab (Figure 1).

[ TT]Canfig | 23:21:40

Calibration

Lacation: Pullman, LA

Oate: Jan 02, 2000

Time: 2.3:21

Daylight Sawings: Off =,

Figure 1 Configuration tab
3. Use UPand DOWN to highlight Location.
Press ENTER.

The system location will display as options Country, City, Latitude, and Longitude
(Figure 2).
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Location

F

Country: United 5

City: Pullman, WA
Latitude: 47°
Longitude: -117°

UTC Offset: -8.0 hours

1

Figure2 Location screen

NOTE: North latitudes are positive and south latitudes are negative. East longitudes are positive and west
longitudes negative.

Use UP and DOWN to highlight the desired options, and press ENTER to access the lists
to update the selections appropriately.

Press ESC when all displayed location information is correct.
Press DOWN to highlight Date.
Press ENTER.

The system date appears in the center of the screen in day/month/year format (Figure 3).
Arrows appear above and below the first value, indicating the value can be edited.

Date

JEn 0z, 2000

Figure 3 Date screen

Use UP and DOWN to change the first number. Holding down the arrow buttons will scroll
quickly between values.

Press ENTER to move to the next value or ESC to return to the previous value.
Repeat step 9 and step 10 until the correct date is selected.

After the last value is changed, press ENTER to return to the Configuration tab.
Use DOWN to highlight Daylight Savings.

Use ENTER to toggle daylight savings to On or 0ff.

Use UP to highlight Time.

Press ENTER.
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The system time appears in the center of the screen in 24-h format (Figure 4). Arrows
appear above and below the first value, indicating the value can be edited.

Time

1}:33:1:5:

Figure 4 Time screen

17. Use UP and DOWN to change the first number. Holding down the arrow buttons will scroll
quickly between values.

18. Press ENTER to move to the next value or ESC to return to the previous value.
19. Repeat step 17 and step 18 until the correct time is selected.
20. Afterthe last value is changed, press ENTER to return to the Configuration tab.

21. Press MENU to return to the main screen.

2.2 TAKING MEASUREMENTS

The LP-80 measures PAR using the sensors in the probe. Under a plant canopy, radiation
levels can vary, so reliable measurement of PAR requires many samples at different
locations. An external point sensor may be used to collect instantaneous above-canopy PAR
measurements when sampling under or within a canopy.

Intercepted PAR data can be used for determining important parameters of canopy structure
and for the calculation of LAI. The LP-80 uses several variables to calculate Leaf Area Index
(LAI) and displays values for these variables on the screen as measurements are taken
(Figure 5).

Average below-canopy PAR readings

Average above-canopy PAR readings

161 ?I:II:I <4— Current time

Active tab —» |PHR
Active Reading symbol —» m ’_> 214
Current above-canopy PAR reading

-fl <4—— Number of above-canopy PAR readings
Current below-canopy PAR reading 4>1

3 <4—— Number of below-canopy PAR readings

LAI F, z

Figure5 PARtab
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« PAR: radiation in the 400- to 700-nm waveband, representing the portion of the spectrum
that plants use for photosynthesis.

« T (tau): ratio of below-canopy PAR measurements to the most recent above-canopy PAR
measurement, calculated automatically by the LP-80.

« LAI: the area of leaves per unit area of soil surface.

« F, (fractional beam radiation): ratio of direct beam radiation coming from the sun to
radiation gathered from all ambient sources, like the atmosphere, or reflected from other
surfaces.

* x (leaf distribution parameter): ratio of the projected area of an average canopy element
(a leaf, for example) on a horizontal plane to its projection on a vertical plane; the default
value for x is 1.0, which assumes the canopy angle distribution to be spherical.

« z (zenith angle): angle between the point in the sky directly overhead vertical, called the
zenith (0°), and the position of the sun. The angle is calculated based on the global position,
time of day, and location, and the correct information must be configured in the LP-80 for
this value to be accurate (Section 2.1).

More in-depth explanations and examples of these measurements are in Section 3.4 and
the Glossary.

The LP-80 can take measurements either manually or in unattended logging mode, as
explained in Section 2.2.2 and Section 2.2.3, respectively.

2.2.1 MEASUREMENTTIPS

ABOVE-CANOPY (EXTERNAL) SENSOR

For above-canopy PAR data collection, consider connecting the external sensor to the
LP-80. This ensures an accurate measurement of intercepted PAR, especially on days where
radiation levels vary rapidly. The sensor can be mounted on a tripod and leveled with a
bubble level.

When it is not feasible to use an external sensor to obtain above-canopy measurements,
such as in timber or tropical crops, choose one of two options:

Use a separate data logger with an attached PAR sensor (such as a point quantum sensor) or
configure another LP-80 to log in the unattended mode (one reading per minute, for example)
in a clearing outside the canopy. After collecting PAR data within the canopy, download the
data from the two instruments to a computer and correlate the data.

Use the LP-80 as an above-canopy reference by regularly collecting above-canopy PAR data
in a large clearing within the canopy structure.
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SAMPLE SIZE

When evaluating experimental protocols for measuring average intercepted PAR and
determining average LAl for a large area, plan for a sufficient number of samples and
sampling locations. This will reduce errors caused by canopy structure variations.

ACTIVE PROBE SEGMENTS

When evaluating discontinuous canopies or canopies with definite clumping, the LP-80 can
be configured such that its active sampling area is reduced or you can download the data
collected by the probe segments. In this way, information can be gathered that better
describes the changes in canopy structure with regard to location. Reduce the sampling

size of the probe using the Set Active Segments option in the Configuration tab. View the
individual PAR readings for each of the eight probe segments by downloading the stored data
to the computer.

The number of active segments in the probe can also be changed to limit the number
of active sensors along the probe or to reflect spatial changes in the plant canopy
(Section 3.2.1). This is useful when evaluating discontinuous and irregular canopies.

SAMPLING IN ROW CROPS

When using the LP-80 to measure in crop rows, take measurements in a way to give a good
row-to-row representation of the entire below-canopy PAR environment both under the
plants and between rows. METER suggests either of the sampling regimes below, where the
probe either extends from mid-row to mid-row (Figure 6) or extends from mid-row to the
middle of the open space between rows (Figure 7), depending on row width and canopy size.

Figure 6 The two ends of the LP-80 probe are in the middle of each row, getting a good representative
sample of the entire area below and between rows
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Figure 7 The base of the probe is in the center of the row and the end is in the center of the open space
between rows. When sampling the next row, the same orientation is maintained, giving an accurate
representation of the overall area.

2.2.2 MANUAL MEASUREMENTS
1. Navigate to the PAR tab.

2. To make an above-canopy PAR measurement, press UP.
The resulting value displays in the upper right section of the screen.

3. To make measurements below the canopy, plug in a external sensor or take an above
canopy PAR reading first before the summary data can update. If the external sensor is
attached, the LP-80 records both above- and below-canopy readings pressing either the
UP or DOWN.

4. To make measurements below the canopy, press DOWN or PAR-LAI in the upper right
corner of the keypad.

The LP-80 recalculates summary data after each below-canopy PAR reading. Other
relevant data displays at the bottom of the screen (Figure 8).

|PAR 16:1 7:00
- C U

m
1 HRAGL

mes

4l

Figure 8 Active PAR measurement screen
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LP-80 updates and displays the current calculated <, LAl, F,, X, and z values at the
bottom of the screen with each subsequent below-canopy PAR measurement.

With each above- or below-canopy measurement, a number appears to the right of the
PAR value that indicates the number of completed measurements. The displayed PAR
value reflects the sample average. In Figure 8, the LP-80 made four above and three
below-canopy measurements, so the average of the four above-canopy PAR values is
211 ymol/(m?2s), while the average of the three below-canopy values is 20 pmol/(m?s).
NOTE: When connected to the external sensor, the LP-80 uses readings from the external sensor as above-

canopy PAR readings to calculate LAIl. Summary data on the bottom of the screen are recalculated using the last
above-canopy reading with each subsequent below-canopy reading.

Press ENTER to bring up the Save screen to save as is, annotate, or discard (Section 2.3).
Press ESC to discard the values.

Both options clear the screen for new data.

2.2.3 LOG MODE MEASUREMENTS

NOTE: LAl and T are calculated more accurately by manually sampling PAR beneath a canopy at random locations
instead of leaving the LP-80 in one place and collecting data in log mode.

1.
2.

Navigate to the Log tab.

Select the measurement interval by pressing the UP or DOWN arrows to select any value
between 1 and 60 min.

To activate the logging mode, press ENTER. The screen will begin to return data
(Figure 9).

To cancel the logging mode, press ESC.
NOTE: Other tabs can be viewed while the logging mode is activated.

[JLiag [T1]  16:30:06
£h Ty ML Log:  O:O0CET

arna Wake: 10 min
13 %% count: 1

Figure9 Logtab with measurements set every 1 min

The LP-80 saves data taken in this mode automatically (without annotation). While
activated, the LP-80 continues to log data until logging mode is canceled.

NOTE: This mode is for short-term experiments (1 or 2 days). The LP-80 is not designed to be left in the field for
long periods of time.
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2.3 SAVING AND ANNOTATING READINGS
To save a reading after taking above and below PAR data,
1. Press ENTER.

The Save Method screen appears (Figure 10).

Save [Method
moSanye

2 Annotate
2 Discard

|
o L

Figure 10 Save Method screen
2. Choose to save, annotate, or discard data.

¢ Save:data stores with the time and date of the measurement.
¢ Discard: return to the main screen and start over with a new reading.
* Annotate: create a file name or description (Figure 11).

Annotate
I0:

ROSE EBUSH

L2

4l
o L

20

Figure 11 Annotate screen

The Annotate screen has a series of lines with a set of arrows above and below the first.
Old annotations will appear to be changed or deleted. Use the arrow keys to select a
letter or number and press ENTER to move to each character.

3. Return to the PAR tab when the annotation is complete.
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2.4 VIEWING DATA

To view prior test results, use the following steps:

1. Press MENU to navigate to the Data tab (Figure 12).

[ 1]Data [1 232108

Download
Erase

1% Readings
2o of 1024KE used.

Figure 12 Data screen
2. Press ENTER to select View.

. Scroll through the list of saved tests using UP and DOWN (Figure 13).

Wiew 1515

|:|3 15 10.16:23:119
|:|3.'"15.'"1|:| 16:17:086
0350161453
0350160828

Figure 13 View data summary screen
. Press ENTER to select View.

"

Each entry shows the details of the saved measurement (Figure 14).
Sample 3B 1/15

Mar 15, 2010
16:28:42

41 1k

2 -2

0.05%] 1.75 ] 0.20] 1.00

Figure 14 View data detail screen
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2.5 DOWNLOADING DATA

METER recommends using the LP-80 Utility to download data. This function transfers all
saved measurement data on the LP-80 to a computer.

1. Connect the 5-pin connector to the LP-80.

2. Connect the RS-232 end of the cable to an available serial port on a computer or to a
USB-to-serial adapter.

3. Turnonthe LP-80 by pressing the POWER button.
Open LP-80 Utility.

Choose the appropriate communication port from the Use computer communication port
dropdown on the main window.

6. Click Download in the lower left of the screen or click File > Download Data.
The Save LP-80 Data dialog box will appear.
Name the data file.
Choose the location and the format for the file (Section 3.3)
The file can be saved as one of the following:
+ Microsoft® Excel® Workbook (*.xls)
+ Text (tab delimited) (*.txt)
+ CSV(comma delimited) (*.csv)
9. Click Save to download.
A progress bar shows the status of the download process.

10. Press Cancel to cancel the download at any time. The software will not save any
downloaded data.

11. When the download is finished, a prompt will ask to erase the data on the LP-80.
12. Select the desired response.
13. Navigate to the saved file location and open the file to view the data.

Data are organized in the same way regardless of format. The measurement record will be
divided into several columns.

« Record Type: The data record type (SUM, ABV, or BLW).
» Date and Time Measurement: Date and time of the reading.
« Annotation: The annotation is a string that a user may use to identify the reading.

» Average Above PAR: The average of all the above-canopy PAR readings for the raw records
associated with the summary record.

« Average Below PAR: The average of all the below-canopy PAR readings for the raw records
associated with the summary record.

* 1: Ratio of below-canopy PAR measurements (MeanBlw) to the above-canopy PAR
measurements (MeanAbv).

1
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« LAI: Area of leaves per unit area of soil surface.

* x: Ratio of projected area of an average-canopy element on a horizontal plane to its
projection on a vertical plane.

 F,: Ratio of direct beam radiation coming directly from the sun to radiation coming from all
ambient sources.

« z: Angle the sun makes with respect to the zenith (point in sky directly overhead).
e Latitude: Latitude location in degrees.

 Longitude: Longitude location in degrees.

« Segment 1-8 PAR: Individual PAR readings from each of the eight segments.

« External Sensor PAR: PAR reading from the external sensor.

« Record ID (RID): Unique identifier for each record.

« Raw Record ID: RID of the first raw record associated with the summary record. Any
record between the RawRID and the RID of the summary record is also associated with the
summary record.

Data can also be downloaded through the LP-80 or a terminal program, if the LP-80 Utility is
not functioning properly. Contact Customer Support for more information.

2.6 ERASING DATA

Data can be erased using the LP-80 or the LP-80 Utility. Data cannot be erased one
measurement at a time. This feature erases all data from the LP-80 permanently and it
cannot be recovered!

WARNING: Once data has been erased, it cannot be recovered.

To erase all stored data from LP-80:
1. Press MENU to navigate to the Data tab.
2. Use UP or DOWN to highlight Erase.
3. Press ENTER.
The following warning will appear (Figure 15).

Erase

Eraze all ztored data?

Figure 15 Warning confirming to erase all stored data

12
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To return to the Data tab and leave stored data intact, press ESC.

To erase data from memory, press ENTER.
NOTE: This will delete all data permanently.

When the process is complete, the Data tab will reappear.

To erase all stored data using the LP-80 Utility:

1.
2.

Make sure the LP-80 is properly connected to the computer.

Click Erase in the lower left of the screen, or go to File > Erase Data.

A confirmation dialog box will appear.

Click OK to continue.

Click Cancel to return to the main screen.

A progress bar will appear on the main screen, indicating that data is being erased.

13
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3. SYSTEM

This section describes the specifications, components, and theory of the LP-80.

3.1 SPECIFICATIONS
MEASUREMENT SPECIFICATIONS

Probe PAR Sensors
Range 0 to 2,500 umol/(m?2s)
Resolution 1 pmol/(m?2s)
External PAR Sensor
Range 0 to 4,000 pmol/(m?2s) (full sunlight ~2,000 pmol/[m?s])
Resolution 1 pmol/(m?2s)
Accuracy 5%

Unattended Logging Interval

Between 1 and 60 min (user selectable)

PHYSICAL SPECIFICATIONS

Controller Dimensions

Length 15.80 cm (6.20 in)

Width 9.50cm (3.75in)

Height 3.30cm (1.30in)

Weight 0.55 kg (1.21 lb) with batteries
Probe Dimensions

Length 86.5 cm (34.06 in)

Width 19.0cm (0.75 in)

Height 9.5¢cm (0.38in)
External Sensor Dimensions

Diameter 24.0 mm (0.94 in)

Height 27.0 mm (1.06 in)
Probe Sensors

Number 80

Type Photosynthetically active radiation sensor

14
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External Sensor
Number 1
Type Apogee SQ110 photosynthetically active radiation sensor

Operating Temperature Range
Minimum 0o°C
Maximum 50°C

Operating Relative Humidity Range

Minimum 0%
Maximum 100%
Power

4 AAA batteries, included
Data Storage

1 MB flash memory
External PAR Sensor

Locking 5-pin sealed circular connector on 2-m cable
Computer Interface

Locking 5-pin sealed circular connector to RS-232 cable

COMPLIANCE
Manufactured under ISO 9001:2015
EM ISO/IEC 17050:2010 (CE Mark)

3.2 COMPONENTS

The LP-80 is a menu-driven, battery-operated linear PAR ceptometer used to measure

light interception in plant canopies and to calculate Leaf Area Index (LAI). It consists of an
integrated microprocessor-driven data logger and probe (Figure 16). The LP-80 displays PAR
in units of micromols per meter squared per second (umol/[m?s]). The instrument is capable
of handheld or unattended measurement.

15
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Figure 16 LP-80 ceptometer

The LP-80 can be operated in environments with temperatures from 0 to 50 °C and in relative
humidities of up to 100%. The LP-80 operates on four AAA alkaline batteries. The instrument
ships with an RS-232 interface cable for downloading data to a computer.

3.2.1 PROBE

The probe contains 80 independent sensors, spaced 1 cm apart. The photosensors measure
photosynthetically active radiation in the 400- to 700-nm waveband.

For some applications, the entire probe may not be needed. The LP-80 allows sections of
the probe to be turned off, starting from the base and continuing up the probe to the tip
(Section 2.2.1).

3.2.2 EXTERNAL PAR SENSOR

The LP-80 has an external PAR sensor that attaches to the hole in the bubble level and
connects to the port on the right side of the LP-80. It allows for simultaneous above- and
below-canopy PAR readings without moving the LP-80 above and below the canopy. The
LP-80 uses this sensor to calibrate the probe, ensuring that the PAR response between the
external sensor and the probe are the same (Section 4.1).

The external quantum sensor provided with the LP-80 is the Apogee SQ110. This sensor
offers good accuracy; however, the biggest potential error is often caused by small changes
in the position of the sensor. The sensor must be exactly horizontal for the most accurate
measurements.

16
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3.2.3 KEYPAD

The LP-80 keypad is a 7-button panel, designed for ease of use and intuitive navigability

through the operating system (Figure 17).

*« POWER: Turns the instrument on or off. The LP-80 turns itself off automatically after
10 min of inactivity.

*« MENU: Cycles between the four tabs.

« UP and DOWN: In the PAR tab, the UP arrow initiates above canopy PAR readings and the
DOWN arrow initiates below canopy readings. In other tabs, they are used to navigate to
items or to change numeric values.

* PAR-LAI: Begins a below-canopy measurement; alternative when taking multiple below-
canopy PAR samples.

« ESC: Cancels the current PAR reading, cancels out of current options, and navigates to the
left in the Annotation screen.

« ENTER: Saves the current PAR readings in the PAR sampling tab, selects items in other
tabs, and navigates to the right in the Annotation screen.

Figure 17 LP-80 keypad

3.2.4 DISPLAY

The LP-80 display has four main screens: PAR, Log, Data, and Configuration. The screens are
indicated by the four tabs, with the active tab in the foreground. Cycle between the four tabs
by pressing the MENU and select items within each tab using the UP and DOWN arrows.

17
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The default screen is the PAR sampling tab with real-time PAR data displayed in the center
portion of the screen (Figure 18). If the battery is low, a low-battery indicator will appear
between the tabs and the current time.

[FRF

0.000] 000 | 0.0d | 0.00

Figure 18 LP-80display

PARTAB
The PAR tab is the PAR/LAI sampling screen, which is used for taking measurements with the
LP-80 (Section 2.2).

The PAR tab in Figure 19 indicates that the current real-time PAR level is 2 pmol/(m?s) (an
indoor measurement) and that the user did not take any above or below PAR measurements.
If the external sensor is attached, the real-time PAR value measured by the external sensor
also display above the real-time light bar PAR data.

23204

0.000] 000 | .0d | 0.00

Figure 19 PARtab

LOG TAB

The Log tab is used to put the instrument in an unattended data logging mode (Figure 20). In
this mode, the LP-80 will automatically measure and store PAR data at a specified interval
(Section 2.2.3).

18
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[JLog [T1  1e:2352
=7l "’“z"'- Log: OFF

prieL Wake: ¥1 min
12 5% count: 0

I:I.I:II:II:I‘ I:I.IIIIII‘ I:I.IIIIII‘ I:I.IIIIII‘ IIII

Figure 20 Logtab

DATATAB

The Data tab is to view, download, and erase data and displays a summary of records and
memory use (Figure 21).

« View: Select to see reading time, measurement, and annotation (Section 2.4).
« Download: Select to send data to computer (Section 2.5).

« Erase: Select to delete data from controller memory (Section 2.6).

[ 1]Data [1 232108

Download
Eraze

1% Readings
2% of 1024KE uszed. +

Figure 21 Data tab

CONFIGURATION TAB
The Configuration tab is a menu to alter system settings and set other parameters that affect
the functionality of the LP-80.

| | | |EnnF|g 232140 [TT]Canfig 232254 [T ]Config 171Gz
atio llL=af Distribution = 1 00 &

Ln:u:atln:-n Fullman, WA Ext Senzor Const: 5.00
Date: Tan 02, 2000 Active Segments: &
Time: 23:21 Fower Filter: S0Hz

Daylight Sawings: OFf Y LContrast

Figure 22 Configuration tab options

19
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This menu features eleven options:

« Calibration

Calibration will begin the calibration process (Section 4.1). The external PAR sensor
(Section 3.2.2) will be needed to complete calibration.

« Location

The location must be set to the appropriate country, city, latitude, and longitude prior to use
to make accurate LAl calculations (Figure 23; Section 2.1).

Location
Country: United 5t

F

City: Pullman, WA
Latitude: 47°
Longitude: -117°

UTC Offset: -2.0 hours

Figure 23 Location screen

1

North latitudes are designated positive and south latitudes are negative; east longitudes
are positive and west longitudes negative.

» Date
The date must be changed prior to use to record accurate information (Section 2.1). LP-80
uses the date provided to calculate z and F, values. The date can also be changed in the
LP-80 Utility.

* Time
The time must be changed prior to use to record accurate information (Section 2.1).

« Daylight Savings
Daylight savings must be toggled on or off prior to use to record accurate information

(Section 2.1). LP-80 uses this parameter to calculate z and F, values. When daylight savings
is on, the time will automatically adjust.

« Leaf Distribution

This selection adjusts the leaf distribution parameter for the plant canopy to be measured.
Use UP and DOWN to change the value of the % parameter. Press ENTER to save.

« External Sensor Constant

This selection adjusts the calibration constant of the external sensor (Section 3.2.2). This
should only be changed when using a new or recently recalibrated external sensor. The
external sensor constant value should match the value on external sensor cable tag.

Use UP and DOWN to set the correct value, and press ENTER to save.

20
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« Active Segments
The Active Segments screen changes the number of active segments on the probe

(Figure 24).

Active Segments

400k

Figure 24 Active segments screen

Use UP and DOWN to set the desired active segments. The icon on the right side of the
screen will illustrate the active segments as the number is increased or decreased. Press
ENTER to save.

If fewer than eight segments are active, the number of active segments will appear on the
PAR and Log tabs.

NOTE: If a segment is deactivated, that segment data will record 0. Deactivated segment numbers will not be used in
LAl calculation.

« Power Filter

A power noise filter value may be needed to elimate noise from AC-powered light sources
on sensor measurements. Highlight Power Filter: and use ENTER to toggle between
either 60 Hz or 50 Hz.

NOTE: North American and Asian light sources use 60 Hz. Most European light sources use 50 Hz.

« Contrast

The Contrast screen controls the screen contrast (Figure 25). Use UP and DOWN to set the
correct level. Press ENTER to save or ESC to cancel adjustments.

Contrast

=2 the UF and DOUIM
arrows to change the
contrast lewel

Figure 25 Contrast screen
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« About

The About screen displays the LP-80 serial number, firmware version number, and copyright
information (Figure 26).

Abiout

Serial: 1234

Firmware: LP30 1.53
Copyright @ 2003-2020
METER Group, Inc. USA

Figure 26 About screen

3.3 LP-80 UTILITY

The LP-80 Utility is a program designed specifically for interfacing with the LP-80. This
program can be used to download measurement data to a computer, erase LP-80 data, set
the date and time, and see information about the LP-80.

Install the LP-80 using the included USB drive (inside the cover of the LP-80 Manual). The
latest version of the LP-80 Utility can also be installed from metergroup.com/lp80-support.

1. Insertthe USB into the USB port.
2. Open the USB drive named METER Group Inc. USA.
3.  Move the LP-80 Utility application onto the computer’s hard drive.

The four menus across the top of the screen change program and LP-80 settings. Below is a
brief overview of the options each menu contains.

FILE MENU

« Download Data: Saves measurement data stored in the LP-80 as a data file on the
computer (Section 2.5).

« Erase Data: Erases all data in LP-80 (Section 2.6).
« Exit: Quits the program.

EDIT MENU

» Preferences: Opens the Preferences window.
The Preferences window has three tabs: Data File, Communications, and Application tabs.

The Data File tab is used to change column headers and the date/time format.
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« Column headers checkbox includes column headers for saved data files (Section 2.5). This
feature is on by default.

» Date/Time Format sets how the date and time are displayed in saved data files. By default,
the program will use Windows Regional and Language Options (the system settings
accessible in the Windows Control Panel).

The Communications tab is to change settings in communicating with the LP-80. These
should only need to be changed if troubleshooting a connection issue.

« Command Retries: Set the number of times the computer should automatically try sending
communications commands (up to 10).

* Maximum Baud Rate: Set the maximum baud rate for talking to the LP-80.

The Application tab sets application preferences.

» Automatic Internet Version Check: Select to automatically check for updates for the
LP-80 Utility when connected to the internet. Updates can be manually searched for in the
Help menu.

« Automatic Clock Synchronization: Sets the LP-80 time to the computer time automatically,
when connected.

« Error Log File: Adds additional details to error log files, which can be sent to METER for
troubleshooting.

ACTIONS MENU
» Set Date/Time: Synchronizes the LP-80 date and time to the computer date and time.

« View Information: Displays the serial number, firmware version, firmware checksum status,
battery level, number of stored readings in the LP-80, and current date and time.

HELP MENU

» Help...: Accesses the LP-80 Utility help file that provides detailed information on how to
use the program.

» Send Feedback to METER: Provides the user with a way to submit feedback to METER.

» Check for Software Updates: Checks for application updates.

» Check for Firmware Updates: Checks for firmware updates for the LP-80.

» About LP-80 Utility: Displays the current program version.

Occasionally, METER releases firmware updates for the LP-80 to improve the performance
of the instrument. These updates can be found through the LP-80 Utility Help Menu. Do not

turn off or disconnect the instrument from the communication port while the firmware is
updating.

WARNING: Any data records on the instrument will be erased during a firmware update. Download data before loading
new firmware.
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To update the firmware, use the following steps:

1. Connect the LP-80 to an available communication port.

2. Download the LP-80 Firmware Updater executable file from the LP-80 product website
(metergroup.com/lp80-support).

3. ClickRun.

If the application does not automatically ask, open the firmware updater application
from the Downloads menu.

A warning will appear to download all saved data.
4.  Click OK.
The LP-80 Firmware Updater window should appear.
Select the correct communication port in the dropdown list.
Click Start.

When the firmware updater is finished, close the application.

3.4 THEORY

The LP-80 is useful for a number of applications, including the measurement of average
and intercepted PAR. PAR is the radiation in the 400- to 700-nm waveband. It represents
the portion of the solar spectrum that plants use for photosynthesis. Under a plant canopy,
radiation levels can vary from full sun to deep shade over the space of a few centimeters.
Therefore, reliable measurement of PAR requires many samples at different locations
under the canopy. The LP-80 calculates LAl and other attributes of the canopy structure
with these measurements.

3.4.1 AVERAGE AND INTERCEPTED PAR

Monteith (1977) observed that dry matter production of a plant canopy is directly related
to the amount of photosynthetically useful radiation intercepted by the canopy. Dry matter
production (P) is modeled as the product of three terms:

P= ejS Equation 1
where ¢ is a conversion efficiency, fis the fraction of incident radiation intercepted by the
crop, and S is the flux density of incident radiation intercepted by the crop. Conversion
efficiency (e) and fractional interception (f) are determined by crop physiology and
management.

Incident solar radiation is the only environmental factor. If fand S are monitored over the
period of crop growth and P is measured at harvest, e can be determined. The results of
experimental treatments or the influence of genetics can be interpreted in terms of their
effectoneandf.
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The incident radiation on a canopy can be (1) absorbed by the canopy, (2) transmitted
through the canopy and absorbed or reflected at the soil surface, or (3) reflected by the
canopy. In principle, only PAR absorbed by the canopy is useful in producing dry matter,
so fshould be the fractional absorption. Equation 1 delineates the parameters needed to
calculate f:

f=l-t-r-m Equation 2

where tis the fraction of incident radiation transmitted by the canopy, r is the fraction of
incident radiation reflected to a sensor above the canopy, and r, is the reflectance of the soil
surface.

The last two terms are often ignored, so approximate fractional interception is
f =1-t¢ Equation 3

The error resulting from this approximation is usually small when ¢, r, and r, are measured

in the PAR waveband because most PAR is absorbed by a closed canopy. The error becomes
much more significant when measurements of total solar radiation are used because of large
scattering coefficients of leaves for near-infrared radiation.

As afirst-order estimate of error, assume that
r= (1 - t)”; + t’”s Equation 4
where r, is the reflectance of the vegetation. Equation 2 then becomes

f:(l_t)(l_rc) Equation 5

The error resulting from using Equation 3 is approximately equal to r,, which is typically
<0.05 in the PAR waveband. Since the LP-80 sensors are sensitive only to radiation in the
PAR waveband, Equation 3 will be fairly accurate for making measurements of intercepted
radiation. However, measurement of the other terms needed for Equation 2 is simple and are
dealt with later.

3.4.2 SAMPLING FOR FRACTIONAL INTERCEPTION

The functions needed to perform these calculations are available in the PAR sampling tab
of the LP-80. The measurements needed for fractional interception are those from which ¢,
r,and r, are calculated. If S is the PAR reading from an upward-facing LP-80 above the plant
canopy, R is the reflected PAR above the plant canopy (inverted LP-80 above the crop), T is
the upward-facing LP-80 below the plant canopy, and U is the reflected PAR from the soil
surface, then s, r,and r, can be calculated with Equation 6 through Equation 8.

t=T/8S Equation 6
r=R/S Equation 7
r= u/r Equation 8
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Assume only 7 needs to be done and S needs to be measured above the crop canopy. Level the
LP-80 above the canopy and press UP. The reading displayed in the upper right portion of the
screen is the value for S.

Measure T by placing the LP-80 below the plant canopy. Carefully place it below all of the
leaves and keep the instrument level. Press DOWN. The resulting values are displayed
below the above-canopy values on the screen. Since the light below the canopy is extremely
variable, several samples at different locations will be necessary for a reliable reading. The
number of necessary samples can be determined by taking, for example, ten individual
readings and computing the coefficient of variation (CV) with Equation 9.

s
CV==
T Equation 9

where s is the standard deviation of the 10 readings:

oo | 20T

n-1 Equation 10

where n is the number of samples taken. The fractional error in the measurement of 7 will be
CV divided by the square root of the number of samples.

After the first below-canopy PAR measurement, the current t value will displayed in the
lower left corner of the screen. With each subsequent below-canopy measurement, the t
value will be updated. After sufficient measurements, use the displayed < value in the lower
left corner for ¢ (Equation 6).

To find r (Equation 7), level the LP-80 above the canopy and press UP. Then invert the
LP-80 at a height of 1 or 2 m above the crop canopy. Leveling is not critical for this
measurement since the radiation reaching the sensor is not directional. Press DOWN in
the PAR sampling tab. Multiple readings are typically not necessary, since R is not usually
variable. r for Equation 7 is shown in the T location at the bottom of the LP-80 screen.

To find ry, invert the LP-80 over the soil below the canopy and take measurements at several
locations. Average and store these measurements as before. This reading is the value

U. Calculate r, from Equation 8 using U and t. A value in the range of 0.1 to 0.2 should be
obtained, but it is possible that the light level below the canopy will be so low that U will
not be accurately measured. If a value outside of the expected range is obtained, there will
be negligible error in fby assuming r = 0.15. As mentioned before, evaluation of intercepted
radiation normally involves the measurement of .

Only measurements below the canopy have been discussed. Obviously, measurements
throughout the canopy are possible. Profiles of interception with height can be useful in
determining at what location most of the photosynthesis occurs in the canopy.
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3.4.3 USING PARTO DETERMINE LEAF AREA INDEX

The PAR measured by the LP-80 within a plant canopy is a combination of radiation
transmitted through the canopy and radiation scattered by leaves within the canopy. A
complete model of transmission and scattering is given by Norman and Jarvis (1975), but it is
very complex and not suitable for inversion. This section will use the Norman-Jarvis model to
test and fit two simpler models that invert more easily.

For the first model, Equation 11 is a simple light scattering model suggested by Goudriaan
(1988). Equation 11 gives the fraction of transmitted PAR (t) below a canopy of LAI (L), as
7= fiexp(—Ja)+(1- £)exp(-0.87/a) Equation 11
where f, is the fraction of incident PAR which is direct beam, a is the leaf absorptivity in the
PAR band (LP-80 assumes 0.9 in LAl sampling routines), and K is the extinction coefficient

for the canopy. The extinction coefficient can be modeled in various ways. If an ellipsoidal
angle distribution function is assumed (Campbell 1986), then

V' +tan®’

x +1.744(x +1.182)°7 Equation 12

where 0 is the zenith angle of the sun and i is a leaf angle distribution parameter. When
x =1, the angle distribution is spherical, and K simplifies to:

1
2cos® Equation 13

As an alternative model, Norman suggests a different equation for predicting scattered and

transmitted PAR:
A(1-0.47 1)L
T:exp{( ( ) }

1-1/2K) f, -1 Equation 14

where
A=0.283+0.785a-0.1594" Equation 15

Both equations predict canopy PAR within a few percent of values from the complete
Norman-Jarvis model. Equation 11 is slightly more accurate, but Equation 14 is much easier
to invert to obtain L. Inverting Equation 14 gives the following:

L [(1-1/2K)f,~1]InT
A(1-0.47£,) Equation 16

The difference in accuracy of the two equations is smaller than other uncertainties in the
method, so the LP-80 uses Equation 14 to determine LAI.
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The LP-80 program utilizes these equations when the instrument is used to automatically
calculate LAI. With the correct local time, date, and leaf distribution parameter, the

LP-80 automatically calculates zenith angle and beam fraction. It then couples these
parameters with collected intercepted PAR data to determine LAI.

This section describes the method of manually collecting PAR data for the determination of
LAl'in a barley and pea canopy.

EXAMPLE PROBLEM 1

PAR was measured at 391 pmol/(m?s) above a barley canopy on an overcast day. The
average of several measurements below the canopy was 62 pmol/(m?s). The fraction of PAR
transmitted by the canopy was therefore

r=2=0.159
391

Since the day was overcast, F, = 0. If a = 0.9, then A = 0.86 (Equation 15). Measurements

on overcast days do not require assumptions about canopy structure (x) or zenith angle (z).

Using Equation 16 to solve for L:

-In0.159
086

2.14

EXAMPLE PROBLEM 2
PAR was measured at 1,614 pmol/(m?s) above a pea canopy and at 80 pmol/(m?s) below the
canopy. The fraction of PAR transmitted by the canopy was therefore

=% 605

The zenith angle was 30° and the F, = 0.881.The A value (Equation 16) is again 0.86. y for
the canopy is unknown, but unless leaves have obvious horizontal or vertical tendencies, a
spherical distribution (or default distribution) can be assumed so y = 1.0.

Using z = 30°, solving forEquation 12 gives K = 0.577.

Substituting these values into Equation 16 results in
L=52

3.4.4 EXTINCTION COEFFICIENT AND CANOPY STRUCTURE

If the elements of a canopy are randomly distributed in space, then the probability of a ray
of light, or other probe, penetrating the canopy without interception can be calculated from
theory. The probability of penetration without interception is equal to the sunfleck fraction,
which is the beam transmission coefficient, t®, for the canopy. The parameter @ is the
zenith angle of the probe or solar beam.t usually varies with zenith angle. The transmission
coefficient for a canopy of randomly placed elements is:

70 = exp(-KL) Equation 17
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where L is the LAl of the canopy (area of leaves per unit area of soil surface) and K is the
extinction coefficient for the canopy, which depends on the leaf angle distribution of canopy
elements and the zenith angle of the probe.

A number of expressions have been proposed for K. The most useful is from Campbell (1986)
where the angle distribution of canopy elements is assumed to be ellipsoidal. One can
picture the angle distribution of area in a plant canopy to be similar to the angle distribution
of area on the surface of oblate or prolate spheroids, or spheres. The equation for K is

)’ +tan @’

x+1.744(x +1.182)°7 Equation 18

% is the ratio of the length of the horizontal to the vertical axis of the spheroid and can be
measured as the ratio of the projected area of an average canopy element on a horizontal
plane to its projection on a vertical plane. See the Glossary for more discussion of i and
typical values for some canopies.
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Figure 27 Extinction coefficient versus zenith angle

Figure 27 shows the extinction coefficient plotted as a function of zenith angle for various
values of x. There are two important things to note. First, at a zenith angle of about 57°, K is
near unity for all canopies. When leaves are horizontal (large ), K is unity for all elevation
angles, but as y decreases, K becomes smaller at large zenith angles and larger at small
zenith angles.

Equation 17 can be used in various ways to determine the LAl and also the % for a canopy. The
simplest application is that of Bonhomme et al. (1974). Since K = 1 for zenith angles near 57°,
the inversion of Equation 17 is simple and gives:

70 = exp(-KL) Equation 19

If a measurement is made when the zenith angle is about 57° Equation 18 can be used
directly to find L.
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If measurements of the transmission coefficient, t, are made at several elevation angles, a
simple method from Lang (1987) can be used. The measurements of t are used to compute

y=cosOInt® Equation 20

These are regressed on O (in radians), giving a slope (B) and intercept (A). LAl is given by:

L=2(A+B) Equation 21
An approximate value for y is
X =exp(-B/0.4L) Equation 22
EXAMPLE PROBLEM 3
Readings were obtained as given in the following table:
©-deg ®-rad T —-cosOlnT
35 0.61 0.21 1.28
41 0.72 0.18 1.29
55 0.96 0.10 1.32

Linear regression gives the following values for each variable:
A=1.21
B=0.12
L=2(1.21+0.12) = 2.64
% = exp(-0.12 /0.4 x 2.64) = 0.9
A more precise method for finding  is as follows. Find values for x and L which minimize:
F=3(Int,+ KLY

subject to the constraint,y > 0, where T, are transmission coefficients measured at several
zenith angles t, and the K, are the extinction coefficients for the corresponding angles.

3.4.5 CORRECTION OF PAR FOR SUN ANGLE

Canopy transmission (t) measured at one zenith angle can be used to predict transmission
or radiation interception for other zenith angles.

EXAMPLE PROBLEM 4

A measurement might be made at ® = 32° from which cover (1 - transmission at © = 0) is to
be calculated. From Equation 17:
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Int, K

—1__1

Int, K

2 2

=p
so:
7(0,) =1(0,)"

Calculate = from Equation 18:
1
3 )(2+(tan®1)2 2
| A +(tan@,)

If ©; = 0°,

~ ZZ 2
P L{Z +(tan®2)2}

If % is not known, assume y = 1.

EXAMPLE PROBLEM 5

From the measurements in Example Problem 4, find the canopy cover. Take ® = 35° t = 0.21.
The y value is 0.9.

| oy T
P=10.9 + (n3s)y
7(0)=0.21°0.79 = 0.29

Cover=-7(0)=1-0.29=0.71
Intercepted radiation averaged over an entire day can be estimated from:

f =1- T, Equation 23

where T, is the transmission coefficient averaged over all elevation angles. T, can be
calculated from:

~Int, =ul

where 1 and v are functions of i which can be calculated from:

u=1-0.33exp(-0.57y)
v=1-0.33exp(-0.97x)

The following table shows typical values for u and v.
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X u v

0.1 0.69 0.73
0.5 0.75 0.82
1.0 0.81 0.89
2.0 0.90 0.95

4.0 0.96 0.98
8.0 0.99 0.99

Combining Equation 17 and Equation 23 gives:
T, =1(0)
where g=ul"""/K.

EXAMPLE PROBLEM 6
Calculate a value for fractional daily interception for the crop in Example Problems 4 and 5.

u =1.033exp(=0.57x0.9) = 0.80
v =1.033exp(-0.97x0.9) = 0.87

1

(0.9 —[tan35F)? 1.14
= 20733 1 o4 0.59
0.9+1.774(0.9+1.182) 1.94
-0.13
_080x2.64""
0.59

7,=021"=0.15
f=1-1,=1-0.15=0.85

3.4.6 LAIMEASUREMENTS AND NONRANDOM DISTRIBUTION

Since all inversion methods to obtain LAl rely on the assumption that elements of a canopy
are randomly dispersed in space, errors in the measurement of LAl may result from a
nonrandom arrangement of canopy elements. This is especially true for canopies with
heliotropic leaves, conifer forests, row crops before canopy closure, or canopies which never
close, as in desert vegetation. The degree of error in measurement is a result of the canopy
deviation of the canopy from this random dispersion assumption.

Past studies use LAl to relate both actual biomass area and the interception of PAR by a
plant canopy. Another proposed view regarding LAl in which L, the actual biomass area,
relates to a new term, L,, which represents the actual orientation of the canopy elements
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relating to the interception of PAR at a given angle. In situ measurements of LAl using
hemispherical photography were equated with this new term “effective plant area index” (L),
which was defined as:

L =QL Equation 24

where L, represents the actual LAl (equal to a harvested leaf area measurement) and Q
refers to a clumping index resulting from the nonrandom distribution of canopy elements.

When a canopy displays random dispersion, Q is unity; however, when a canopy is clumped,
Q is not unity. In a randomly dispersed canopy, L would be equal to L, (Figure 28). In an
underdispersed canopy (clumped), L would be greater than L, (leaves preferentially shade
the leaves). In an overdispersed canopy, L would be less than L, (leaves are in the open
spaces).

L% S
S

Oy = ESASASAS

Sy S

L=1, L>L, L<L,

Figure 28 Diagrams showing randomly dispersed, underdispersed, and overdispersed
canopies, respectively

The purpose of this discussion is to expose the possible errors that may occur when making
LAl measurements in situ. When setting up an experiment, carefully examine the desired
end result. If the only measurement of interest is interception of PAR within a canopy, the
apparent leaf or plant area index that is calculated through inversion will be an accurate
portrayal of the canopy structure and orientation with respect to light interception. In this
instance, while clumping effects within the canopy remain present, these effects do not
cause error with regard to light interception and the effective area index for that situation.
Alternately, if obtaining the actual biomass (represented by L in this discussion) is desired,
all measurements should be performed to minimize the effects of clumping. The method
used in the LP-80 to compute t follows the recommendation of Lang and Yueqin (1986) for
minimizing clumping effects. Measuring at certain times of day or at positions within the
canopy may also directly minimize clumping effects.

3.4.7 ZENITH ANGLE AND EQUATION OF TIME

The formulas for calculating elevation angle are relatively straightforward. The zenith angle
is calculated with Equation 25:

W = arccos(sin Lat sin D + cos Lat cos Dc0s0.2618(z - ¢,)) Equation 25

using the following definitions:

« Lat = the latitude (negative in the Southern Hemisphere). Latitude of a given site is easily
found in an atlas or using a GPS system.
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« D = solar declination (Equation 26), which ranges from +0.409 radians (+23.45°) at summer
solstice to -0.409 radians (-23.45°) at winter solstice:

D = arcsin{0.39785sin(4.869 + 0.0172J + 0.03345sin(6.224 + 0.0172J)]} .
Equation 26

where J is the day of the year.
« 2.618 = conversion of hours to radians (Earth turns at a rate of 0.2618 radians/h)
o ¢t =time (in hours from 0 to 24).
« 1, = time of solar noon:

4,=12-LC-ET Equation 27

where LC is the longitude correction and ET is the Equation of Time.
Longitude correction is +4 min, or +1/15 h for each degree east of the standard meridian and
-1/15 h for each degree west of the standard meridian. Standard meridians are at 0°, 15°,
30°... etc. Generally, time zones run approximately +7.5° to -7.5° on either side of a standard
meridian, but this varies depending on political boundaries, so check an atlas to find both

standard meridian and longitude. Typically, longitudes in the Eastern Hemisphere are given
as negative values.

The Equation of Time is a 15- to 20-min correction that depends on the day of the year. It can
be calculated from:

_ —104.7sin¢ +596.2sin2¢ + 4.3sin 3¢ — 12.7sin4¢ — 429.3cos ¢ — 2.0cos 2¢ + 19.3cos 3¢9
3,600

ET

Equation 28
where ¢ =(279.575 + 0.986 J)n/180. Some values for ET are given in Table 1.

Table 1 Solar Declination and Equation of Time

Date Day of Year (Ra dl:i)an s) ET Hour

Jan 1 1 -0.403 -0.057
Jan 10 10 -0.386 -0.123
Jan 20 20 -0.355 -0.182
Jan 30 30 -0.312 -0.222
Feb 0 40 -0.261 -0.238
Feb 19 50 -0.202 -0.232
Mar 1 60 -0.138 —-0.208
Mar 11 70 -0.071 -0.117
Mar 21 80 -0.002 -0.122
Mar 31 90 0.067 -0.072
Apr 10 100 0.133 -0.024
Apr 20 110 0.196 0.017
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Table 1 Solar Declination and Equation of Time (continued)

Date Day of Year (Ra dEi)an s) ET Hour
Apr 30 120 0.253 0.046
May 10 130 0.304 0.060
May 20 140 0.346 0.059
May 30 150 0.378 0.043
Jun9 160 0.399 0.015
Jun 19 170 0.409 -0.019
Jan 29 180 0.406 -0.055
Jul9 190 0.392 -0.085
Jul19 200 0.366 -0.103
Jul 29 210 0.331 -0.107
Aug 8 220 0.286 -0.097
Aug 18 230 0.233 -0.065
Aug 28 240 0.174 -0.022
Sep 7 250 0.111 0.0331
Sep 17 260 0.045 0.089
Sep 27 270 -0.023 0.147
Oct 7 280 —-0.091 0.201
Oct 17 290 -0.157 0.243
Oct 27 300 -0.219 0.268
Nov 6 310 -0.275 0.243
Nov 16 320 -0.324 0.255
Nov 26 330 -0.363 0.213
Dec 6 340 -0.391 0.151
Dec 16 350 -0.406 0.075
Dec 26 360 -0.408 -0.007

EXAMPLE PROBLEM 7

Find the zenith angle for Pullman, Washington, USA at 10:45 PDT on June 30. Convert the
time of observation to standard time by subtracting 1 h and convert minutes to decimal
hours,sot=9.75h.

June 30isJ=181.
Pullman latitude is 46.77° or 0.816 radians, and longitude is 117.2°.
The standard meridian for Pullman is 120°.

The local meridian is 2.8° east of the standard meridian, so LC = 2.8/15 = 0.19 h.
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From Equation 28, ET = -0.06 h. Equation 27 then gives 7, = 12 - 0.19 — (-0.06) = 11.87.
Declination from Equation 26 is 0.4 radians.

Substituting these values into Equation 25 gives:

- arccos{Sin(0.816)sin(0.4) +¢05(0.816)c0s(0.4) cos[0.2618(9.75 - 1 1.87)]}

= 0.61 radians
The LP-80 automatically determines zenith angle using the above equation and parameters.
Once correct values are entered in the Configuration tab (Section 2.1), the LP-80 determines

zenith angle without further input. The zenith of the sun angle will then be calculated and
stored at the end of each data set.
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4. SERVICE

This section describes the calibration and maintenance of the LP-80. Troubleshooting
solutions and customer service information are also provided.

4.1 CALIBRATION

The LP-80 calibrates its sensors against the external PAR sensor (Section 3.2.2). However, as
is the case with all electronic components, the external sensor sensitivity will shift over time.
As aresult, METER recommends sending the external sensor to METER for recalibration. For
external PAR sensors that are used heavily, annual calibration is recommended. For periodic
use, one recalibration every 2 to 3 years should be adequate.

METER recommends calibrating the LP-80 to the external PAR sensor at least once per hour
to maintain a stable calibration between the two sensors.

Use the following steps to calibrate the LP-80 to the external PAR sensor.

1.  Unscrew the bolt from the external PAR sensor.

2. Place the external PAR sensor above the hole in the bubble level of the LP-80.

3. Insert the bolt through the hole in the LP-80 from back to front and screw into the
external PAR sensor until hand-tight (Figure 29).

Figure 29 Level the probe

4. Level the probe and sensor in an unshaded area (Figure 30).

NOTE: The LP-80 can also be calibrated on a flat board or platform propped at an angle to get more direct
sunlight.
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Figure 30 Level the LP-80 probe and external sensor
Turn on the LP-80.

Press ENTER to check that the PAR level meets the 600 pmol/(m?s) threshold for
calibration.

If necessary, adjust the sun exposure of the LP-80 to meet the threshold.

NOTE: The PAR level must be above 600 pmol/(m?s) for the calibration to update. In general, a clear day where
the sun is visible will be above 600 pmol/(m?2s). Overcast days are typically less than 600 pmol/(m?s).

Press MENU to navigate to the Configuration tab.
Press ENTER to select Calibration.

A reminder screen will appear (Figure 31).

Calibration

Make =zure PAR readings
are above BO0 pmoldmis
and the probe and
external sensor are lewel
before continuing.

Figure 31 Calibration reminder screen

9. Move out of the probe area to minimize any interference with the measurement.
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10. Press ENTER to perform the calibration.

The current probe calibration will display graphically (Figure 32). (If no external sensor is
attached while performing the calibration, the calibration will return an error.)

Current Calibration

il [ I1]]]

SEG: 1 2 24 5 B V8
Fress ENTER to continue.

Figure 32 Current Calibration screen during calibration

11. Press ENTER again to complete the calibration (Figure 33).

Calibration Complete

11000008

SEG: 1 = 4 5 B 7
F'r'e55 ENTER to =zawe.

Figure 33 Calibration Complete screen

12. Press ENTER again to save.

4.2 MAINTENANCE

LP-80 may be returned to METER for maintenance in the following areas: system inspection,
parts replacement, and instrument cleaning. Replacement parts can also be ordered from
METER. Contact Customer Support for more information.

4.2.1 REPLACING BATTERIES

The LP-80 uses four standard 1.5-V AAA alkaline batteries.These batteries are easily
obtained and should last for at least 2 years before they should be replaced. If a battery icon
appears in the upper right corner of the screen or a low battery message is displayed, follow
these instructions to change the batteries.

NOTE: Data will not be lost when the batteries are replaced. The LP-80 memory and program sections are nonvolatile.
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1. Place the LP-80 with the screen facing down.
2. Usetheincluded Phillips screwdriver to remove the four screws and washers (Figure 34).

3. Holding the case together, turn the LP-80 over, with the screen facing up.

4. Carefully lift the cover and rotate along the bottom to lay the front cover down
(Figure 35).

T
g
=

——————————————/

Figure 35 LP-80 battery locations
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5. Remove and discard old batteries.

6. Insert new batteries, following the indicators on the battery holders.

NOTE: Ensure batteries or oriented properly; placing them the wrong way can damage the LP-80.
7. Pressthe RESET button on the top left corner of the green circuit board.
8. Rotate the cover back into position.
9. Turn the LP-80 over, with the screen facing down.

10. Replace the four washers and screws into the back cover.

4.2.2 CLEANING THE PROBE AND CONTROLLER

The probe should always be clean to ensure accurate readings. To clean the probe, use a soft
cloth and a small amount of isopropyl alcohol. Rub the surface until it is clean.

To clean the controller, use a soft cloth and water to wash off heavy dirt, then use ethyl or
isopropyl alcohol to finish cleaning.

NOTE: Only use a soft cloth when cleaning the LCD window. Tissues made from wood fiber will scratch the window.

4.3 REPAIR

METER repairs manufacturer defects and instruments within the 1-year warranty at no
charge. Repairs outside the warranty window are charged based on cost of parts, labor, and
shipping. An extra fee may be charged for rush work. METER will provide an estimated repair
cost, if requested.

All LP-80 instruments returning to METER for servicing must be accompanied with a Return
Material Authorization (RMA) number. Prior to shipping the instrument, please contact
Customer Support to obtain an RMA number.

1. Place the LP-80in a plastic bag to avoid disfiguring marks from the packaging.
2. Do not ship any accessories.
3. Shipthe LP-80in its original case.

If the original packaging is not available, use a box that has at least 4 in of packing
material (e.g., SytrofoamTM peanuts or bubble wrap) between the instrument and each
wall of the box, ensuring the instrument is suspended in the packing material.

4.  Onthe RMA form, please verify the ship to and bill to information, contact name, and
problem description. If anything is incorrect, please contact Customer Support.

5. Tape the box in both directions for added support.
6. Include the RMA number in the attention line on the shipping label.
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4.4 TROUBLESHOOTING

Table 2 lists common problems and their solutions. If the problem is not listed or these
solutions do not solve the issue, contact Customer Support.

Problem

Instrument does not turn
on

Display is difficult to see

Error message

The external sensor
reading of 0 umol/(m2s)
is too low. Please try
again.

The LAl output is 0 even
though there is a valid
above and below canopy
PAR reading.

Warning message
Low battery.

Warning message
Date and time were reset!
Update the date and time.

Error message

Data erase failed!
Replace batteries. After
replacing batteries,
press ENTER to continue.

Error message
Missing bootstrap loader!
See Manual for options.

Error message
Memory Full.

Table 2 Troubleshooting the LP-80
Possible Solutions
Check that the batteries are inserted correctly.
Replace the batteries.
Adjust the contrast.
Navigate to the Configuration tab.
Scroll down to Contrast.
Use the UP and DOWN to adjust screen contrast level.
Replace the batteries.
Check the connection between the external sensor and the LP-80.
Move the external sensor to full sun and retry.

If the day is overcast, wait to calibrate the sensor on a sunny day when
PAR levels are above 600 umol/(m?2s).

Check the zenith angle value (z) on the PAR screen. z should be
between 0 to 90 degrees. If z is greater than 90 degrees, the time or
latitude/longitude are most likely incorrect. Set the date, time, and
location correctly (Section 2.1).

NOTE: North latitudes are positive and south latitudes are negative. East
longitudes are positive and west longitudes are negative.

Check that the batteries are inserted correctly.

Replace the batteries.

Navigate to the Configuration tab and verify the date and time are
set properly (Section 2.1).

Replace the batteries and turn the LP-80 back on. Press ENTER
when to exit this screen.

The instrument cannot download new firmware updates. The
instrument must be serviced by METER. Contact Customer Support.

Download data records to a computer (Section 2.5) and erase the
LP-80 memory (Section 2.6).
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Table 3 Troubleshooting the LP-80 (continued)
Problem Possible Solutions

This screen means that the firmware was not loaded properly or an
update is needed.

Check metergroup.com/lp80-support if a new firmware version is

Error message available.

Firmware is corrupted!
See Manual for options. NOTE: Saved data records will be lost when new firmware is installed.
Download any data before reloading the new firmware.

If a newer firmware version is not available, contact Customer
Support.

Configuration settings are locked during active reading or logging

Error message mode to prevent inconsistent data from being saved.

Cannot change settings
while Togging! Navigate to the PAR or Log tab and exit the active reading. Make the
desired changes in the Configuration tab and begin a new reading.

Error message

One mode can be run at
a time. Press ENTER to Press ENTER to stop the currently running mode and to continue
stop logging and begin with the new mode, or press MENU to proceed to the next tab
without changing the mode.

Only one mode (either PAR or Log) may be running at a time.

reading.

The view menu only allows you to view summary records. | fyou have
not saved any records or if you only have saved above and below
records, this message will appear when trying to view or download
data. To make this message go away, save a summary recordon the

PAR or Log menu by pressing ENTER.

Error message
No summary data.

Warning message ) . . .
By continuing, you This message will appear when overriding custom location

will lose any custom information.

information. Press ENTER Press ENTER to continue with new information or press ESC to

to continue or ESC to preserve old customer information.
cancel.

4.5 CUSTOMER SUPPORT

NORTH AMERICA

Customer service representatives are available for questions, problems, or feedback Monday
through Friday, 7:00 am to 5:00 pm Pacific time.

Email: support.environment@metergroup.com
sales.environment@metergroup.com

Phone:  +1.509.332.5600
Fax: +1.509.332.5158
Website: metergroup.com
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EUROPE

Customer service representatives are available for questions, problems, or feedback Monday
through Friday, 8:00 to 17:00 Central European time.

Email: support.europe@metergroup.com
sales.europe@metergroup.com

Phone: +49891266520
Fax: +4989 1266 52 20
Website: metergroup.de

If contacting METER by email, please include the following information:

Name Email address
Address Instrument serial number
Phone Description of the problem

NOTE: For products purchased through a distributor, please contact the distributor directly for assistance.

4.6 TERMS AND CONDITIONS

By using METER instruments and documentation, you agree to abide by the METER Group,
Inc. USA Terms and Conditions. Please refer to metergroup.com/terms-conditions for details.
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GLOSSARY

Cosine Response The cosine error for the external sensor for typical applications is <1%.

External Sensor An external PAR sensor allows the LP-80 to make simultaneous above-
and below-canopy PAR measurements. This makes multiple PAR measurements under the
canopy in variable light conditions without having to keep moving the instrument in and out
of the canopy to update the above canopy PAR reference. The external sensor is also the PAR
standard to which the probe is calibrated.

Fraction of Beam Radiation (F,) F, is the ratio of direct beam radiation coming from the sun
to radiation coming from all ambient sources like the atmosphere or reflected from other
surfaces. A fractional beam radiation value is necessary for calculation of LAl using PAR
data.The LP-80 obtains this value by comparing the above-canopy PAR measurement to the
calculated value of potential incoming solar radiation at the location and zenith angle. The
current calculated F, is displayed and updated at the bottom of the screen in the PAR tab.

Leaf Area Index (LAI) or (L) LAl is the area of leaves per unit area of soil surface.

Itis a valuable measurement in helping to assess canopy density and biomass. The
LP-80 calculates LAl based on the above- and below-canopy PAR measurements along
with other variables that relate to the canopy architecture and position of the sun. These
variables are the zenith angle, a fractional beam measurement value, and a leaf area
distribution parameter for the particular canopy.

Leaf Distribution Parameter () 7y refers to the distribution of leaf angles within a canopy
and is the ratio of the length of the horizontal to the vertical axis of the spheroid described
by the leaf angle distribution of a canopy. It can also be measured as the ratio of the
projected area of an average canopy element (a leaf, for example) on a horizontal plane to its
projection on a vertical plane. The default value fory is 1.0, which assumes the canopy angle
distribution to be spherical. Onions are a good example of a strongly vertical crop. For onions,
x would be about 0.7.On the other extreme, strawberries, a crop with a strongly horizontal
nature, would have a  value of about 3.

Table 3 gives some typical values for x. In some cases a range of values is given, indicating
the variability that is to be expected for ¢ in any canopy. Fortunately, the value of LAI
computed is not strongly dependent on the value of x chosen. The LP-80 uses a value of

x = 1.0 as its default.
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Table 3 Typicaly Values

Crop X Crop X
Ryegrass 0.67 Rape 1.92-2.13
Maize 0.76 Cucumber 2.17
Rye 0.80-1.27 Tobacco 1.29-2.22
Wheat 0.96 Potato 1.70-2.47
Barley 1.20 Horse bean 1.81-2.17
Timothy 1.13 Sunflower 1.81-2.31
Sorghum 1.43 White clover 2.47-3.26
Lucerne 1.54 Strawberry 3.03
Hybrid swede 1.29-1.81 Jerusalem Artichoke 2.16
Sugar beet 1.46-1.88

Long-Term Stability The output of all radiation sensors tends to drift over time as the
detector ages. The long-term shift of the sensor is <3% per year.

PAR Photosynthetically active radiation (PAR) is the radiation in the 400- to 700-nm
waveband. It represents the portion of the spectrum which plants use for photosynthesis.
Under a plant canopy, radiation levels can vary from full sun to almost zero over the space
of a few centimeters. Reliable measurements require many samples at different locations
under the canopy. Intercepted PAR data can be used for determining important parameters
of canopy structure and for the calculation of LAI. An external point sensor may be used to
collect instantaneous above-canopy PAR measurements when sampling under or within a
canopy.

Spectral Response Anideal quantum sensor would give equal emphasis to all photons
between 400 and 700 nm and would exclude photons above and below these wavelengths.
Quantum sensors, such as the Apogee, that approximate the ideal response with filters

are accurate to within +3% for common light sources. The spectral response of the Apogee
sensor is such that it underestimates the 400- to 500-nm wavelengths (blue light), matches
in the 550- to 650-nm wavelengths (yellow and orange), and has little sensitivity above

650 nm (red light). Fortunately, common light sources are mixtures of colors and many
spectral errors offset each other.

Tau (r) Tis anothervariable in the LAl inversion equations. It is the ratio of below-
canopy PAR measurements to the most recent-above canopy PAR value. It is measured
automatically by the instrument, based upon the PAR readings. The current t value is
displayed and updated in the lower left corner of the screen in the PAR tab.

Zenith Angle (z) zisthe angle between the point in the sky directly overhead vertical and
the position of the sun (Figure 36). The zenith is 0° and the horizon is 90°. The zenith angle of
the sun is necessary for calculation of certain canopy structure parameters, such as LAl It is
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calculated by the LP-80 based on the global position and the time of day and is displayed in
the lower right corner of the screen when taking PAR measurements. To make sure this value
is accurate, the longitude, latitude, date, and time of day must be set correctly.

Zenith
0°

| \ 4
I A
I
I
I
I

Fh

angle
Elevation
I or altitude

o

Horizon
90°

Figure 36 Zenith angle
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